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IVIVC Tools

Phoenix provides several models for computing correlations between InVitro drug properties, such as 
dissolution, and InVivo responses, such as fraction absorbed. This process is useful for predicting PK 
responses such as maximum concentration or area under the curve.

IVIVC Toolkit brings enhanced deconvolution methods, numerical convolution, dissolution, and cor-
relation models, guided by an “IVIVC Wizard” to pharmacokineticists and formulators.

• IVIVC: Build and manipulate InVitro-InVivo Correlation (IVIVC) models.

• Deconvolution: Evaluate drug absorption from time-concentration data, based on the unit impulse 
response.

• Levy Plot: Comparing predicted and observed concentrations over time as a measure of correla-
tion model fit.

• Loo-Riegelman: Estimate drug absorption assuming a one-compartment (Wagner-Nelson) or 
two-compartment (Loo-Riegelman) PK model. 

• Wagner-Nelson: Estimate drug absorption assuming a one-compartment (Wagner-Nelson) or 
two-compartment (Loo-Riegelman) PK model. 

• Convolution: Estimate or verify PK profiles based on the unit impulse response function and 
expected absorption profile.

• Sigmoidal and Dissolution models: Sigmoidal models, including Hill, Weibull, Double Weibull and 
Makoid-Banakar, for modeling dissolution.
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IVIVC

The IVIVC object provides an organized environment in which to build and manipulate InVitro-InVivo 
Correlation (IVIVC) models. The IVIVC object also estimates the unit impulse response (UIR) for one 
or more profiles given an IV (bolus), infusion, or oral formulation. The IVIVC object supports specifica-
tion and running of all or a subset of operations required to create an IVIVC model, validate it, and use 
it to make PK predictions.

Note that InVitro and InVivo data must be in separate datasets. Individual functions are specified and 
run in the separate panels and tabs of the IVIVC object. 

The IVIVC object contains several sub-workflows or steps. These steps can be executed individually 
during the IVIVC modeling, i.e., it is not necessary to execute the entire object during the IVIVC mod-
eling process. When an IVIVC object is executed, however, all IVIVC steps will run, even if the user 
only wants to run one step. 

Note: If the data for a step is fed into the workflow (e.g., through a data link), executing the IVIVC step 
from the step’s properties panel will not execute the source feeder and can lead to a “lack of 
source” error. If this occurs, execute the full IVIVC workflow object to ensure that sources are exe-
cuted prior to the IVIVC workflow validation.

In vitro data, in vivo data, and dosing data should be similarly scaled for a successful IVIVC (see the 
“IVIVC workflow example” for an example of a full IVIVC workflow). Phoenix IVIVC uses a two-stage 
Level A correlation, where deconvolution is followed by a linear correlation model representing a rela-
tionship between in vitro dissolution and in vivo input rate. The in vitro dissolution and in vivo input 
curves should be directly superimposable or be made superimposable by using a scaling factor (FDA 
1997 Guidance on IVIVC) or by changing units to convert data appropriately. For example, specifying 
in vivo dosing as a very large value will result in large input rates from deconvolution. If dissolution 
data is then given in small-scale numbers, Level A IVIVC may fail to produce accurate results due to 
numerical instabilities, particularly Convolution in the prediction stage may fail to produce non-zero 
concentrations. The dosing data in this case should be scaled by using larger units (e.g., convert ng to 
mg) in order for the input rates to be consistently scaled with the dissolution data.

Use one of the following to add the object to a Workflow:

Right-click menu for a Workflow object: New > IVIVC > IVIVC. 
Main menu: Insert > IVIVC > IVIVC.
Right-click menu for a worksheet: Send To > IVIVC > IVIVC.

Note: To view the object in its own window, select it in the Object Browser and double-click it or press 
ENTER. All instructions for setting up and execution are the same whether the object is viewed in 
its own window or in Phoenix view.

This section contains the following topics:

Status panel
InVitro panels and tab
InVivo panels and tab
Correlation panels and tab
Prediction panels and tab
Status tab
Options tab
Results
Sigmoidal and Dissolution models
Data deficiencies resulting in missing values for PK parameters
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Status panel

The IVIVC object Status panel displays the status of steps that can be completed in the process of 
creating, testing, and using the IVIVC object. Each part of the IVIVC process is listed beside a square 
that uses colors to denote the status of that process.

Green: Process has been run successfully and is up to date.

Yellow: Process is ready to run, but not up to date due to changes to the data in Phoenix or 
IVIVC settings.

Red: Process is not ready to run, one or more required settings or data items is not available.

Click View beside the different steps in the Status Panel to view the associated panel, tab, or dataset. 
This also filters the Results tab list to those generated by the selected operation.

Note: It is not necessary to complete every step to run an IVIVC model.

InVitro panels and tab

InVitro Data panel
InVitro Formulation panel
InVitro Estimates panel
InVitro tab

InVitro Data panel

Use the Main Mappings panel to identify how input variables are used in a IVIVC object. Required 
input is highlighted orange in the interface.

None: Data types mapped to this context are not included in any analysis or output.
InVitro Time: Sampling time values.
InVitro Dissolution: Dissolution data.
InVitro Formulation: Formulation identifiers.
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Note: “Formulation” is a reserved word for InVitro Data. If a column named “Formulation” is mapped to 
InVitro Formulation, it can prevent any requested Levy Plots from being generated. In such a case, 
the IVIVC object must be recreated, settings reapplied, the Formulation column’s name changed, 
remapped, and the object re-executed.

Note: Formulation data that is not mapped in the InVitro Formulation panel is still included in the output 
plots Correlation overlay, Levy plot, and Fabs vs Fdiss. Use the resulting worksheets and create 
plots after filtering the formulation that should not be included (e.g., for the Levy plot, filter 
unwanted data from the “Levy Plots.Tvivo vs Tvitro.Levy Plot Values” worksheet; for the Correla-
tion overlay plot, filter unwanted data from the “Correlation.Abs vs Diss Data” worksheet). In addi-
tion, you must specify the data to plot the line of unity.

InVitro Formulation panel

The InVitro Formulation panel allows users to partition dissolution data. Use the option buttons to 
assign formulations to either internal or external validation. Formulations marked as internal (there 
must be at least one chosen) are used to estimate the correlation (IVIVC). Formulations marked as 
external are only used for validation of the correlation (IVIVC). The InVitro Formulation panel is auto-
matically populated with formulations taken from the dataset mapped to the InVitro Data panel. 
Required input is highlighted orange in the interface.

None: Data types mapped to this context are not included in any analysis or output.
Internal: Validation: Formulation(s) used to build the IVIVC model(s) and for validation on the 
Correlation tab. See “Correlation tab” for more information.
External: Validation: Formulation(s) used in model validation.

InVitro Estimates panel

After the InVitro dissolution and formulation data are mapped, users can specify parameter values for 
different formulations in the InVitro Estimates panel. See “InVitro tab” for initial value, and lower and 
upper bound options.

Depending on the model, users can fix certain parameters to known values. For example, the fraction 
dissolved, Finf, can be fixed to 1.0 to prevent incomplete measurements from biasing other parameter 
estimates. 

All iterative estimation procedures require initial estimates of the parameters. Phoenix can compute 
initial estimates via curve stripping for single-dose PK, PD, PK/PD link, linear or IVIVC models. For all 
other situations, users must supply initial estimates or provide boundaries to be used by Phoenix in 
creating initial estimates via grid search. 

For IVIVC models only, some parameters can be assigned fixed values while others are estimated. 
The fixed command can be used for both modeling and simulating. Fixed parameters use a set value, 
so are no longer considered parameters. This reduces the number of parameters in the model. Statis-
tics such as VIF are not computed for fixed parameters.

None: Data types mapped to this context are not included in any analysis or output.
Sort: Map the formulation data to the Sort context to sort the parameter estimates by formulation.
Parameter: IVIVC model parameters.
Initial: Initial estimates for the parameter.
Fixed or Estimated: Whether or not the initial parameter is fixed or estimated.
Lower: (Available when User Supplied Bounds is selected in the InVitro tab) Lower boundary 
used for parameter estimates.
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Upper: (Available when User Supplied Bounds is selected in the InVitro tab) Upper boundary 
used for parameter estimates.

InVitro tab

In order to provide smoothing, users can fit the dissolution data to a sigmoidal dissolution model.

• Check the Use raw data checkbox to perform linear interpolation on the raw data instead of mod-
eling.

• Select an option button in the Dissolution Model area to select a model. Users can select one of 
four dissolution models: Hill, Weibull, Double Weibull, Makoid-Banakar.
For descriptions of these models, see “Sigmoidal and Dissolution models”.

• In the Weighting menu, select one of five methods for weighting data during modeling (see 
“Weighting” in the NCA section for explanations of the various schemes).

Uniform Weighting
1/Y (weight by 1/observed Y)
1/Yhat (weight by 1/predicted Y [iterative reweighting])
1/(Y*Y) (weight by 1/observed Y2)
1(Yhat*Yhat) (weight by 1/predicted Y2 [iterative reweighting])

• Specify how to determine initial values:

• Select User Supplied Initial Parameter Values to enter initial parameter estimates in the 
InVitro Estimates panel.

• Select WinNonlin Generated Initial Parameter Values to have Phoenix determine the initial 
parameter values.

• Check the Propagate Final Estimates checkbox to propagate initial parameter estimates across 
all sort levels. Users can select this option when more than one sort variable is used in the InVitro 
Data input dataset. If this option is selected, then initial estimates and boundaries are entered or 
mapped only for the first sort level. The final parameter estimates from the first sort level provide 
the initial estimates for each consecutive sort level. 

• Specify how to determine bounds:

• Select User Supplied Bounds to enter lower and upper bounds for each parameter esti-
mate. Enter the boundary values in the Lower and Upper columns in the InVitro Estimates 
panel. Phoenix uses curve stripping to provide initial estimates. If curve stripping fails, then 
Phoenix uses the grid search method. 

• Select Phoenix bounds to have Phoenix generate the lower and upper bounds for each 
parameter. Phoenix uses curve stripping to provide initial estimates, and then applies bound-
aries to the model parameters for model fitting. If curve stripping fails, the model fails because 
Phoenix cannot use grid search for initial estimates without user-supplied boundaries.

• Select Do Not Use Bounds to not apply lower or upper boundaries to parameter estimates.
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Note: When Use raw data is selected, all dissolution model options are made unavailable. Also, the InVi-
tro Estimates panel is removed from the Setup tab.

• Click Fit Dissolution Data to run the model and generate output.

• Click OK in the completion dialog.

InVivo panels and tab

InVivo Data panel
InVivo Dosing panel
InVivo tab
UIR panel
InVivo Fit panel

InVivo Data panel

Use the Main Mappings panel to identify how input variables are used in a IVIVC object. Required 
input is highlighted orange in the interface.

None: Data types mapped to this context are not included in any analysis or output.
Sort: Individual profiles used to sort the output.
Independent: Sampling time values.
Values: Concentration sampling values.
InVivo Formulation: Drug formulation identifiers.

Caution: “Formulation” is a reserved word for InVivo Data. If a column named “Formulation” is mapped to a 
Sort variable, it can prevent the object from performing a prediction. In such a case, the IVIVC 
object must be recreated, settings reapplied, the Formulation column’s name changed, remapped, 
and the object re-executed.

InVivo Dosing panel

Users can specify dosing amounts and infusion times in the InVivo dosing panel. Enter the dosage 
amount for each formulation in the InVivo Dosing panel. For infusions, enter the infusion time for each 
formulation. Required input is highlighted orange in the interface.

None: Data types mapped to this context are not included in any analysis or output.
InVivo Dose: Dose amount.
InVivo Dose Formulation: The formulation associated with each dose amount.
Duration: (Available when Infusion is selected as the Reference Data Type in the InVivo tab) 
Length of time for the infusion.

InVivo tab

The InVivo tab includes settings to identify time-concentration or absorption data, formulations, and 
dosages. Use this tab to fit a unit impulse response (UIR) function to reference concentration data, 
and/or to deconvolve an existing UIR function and concentration data in order to estimate the fraction 
of drug absorbed over time.

Unit Impulse Response area
Formulation information area
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InVivo Data Options area
Generating UIR function and deconvolving data

Unit Impulse Response area

The IVIVC object can compute UIRs for all profiles based on the selected reference formulation. It fits 
a polyexponential function to each profile and chooses the one with the best fit based on either 
Akaike Information Criterion (AIC) or Weighted SSR.

• In the Maximum number of UIR exponentials menu, select the number of exponentials to use
in the UIR function.

• In the Model Selection menu, select the whether to use AIC or Weighted SSR in the UIR func-
tion.

• In the Weighting menu, select one of five methods for weighting data during modeling (See
“Weighting” in the NCA section for explanations of the various schemes).

Uniform Weighting
1/Y (weight by 1/observed Y)
1/Yhat (weight by 1/predicted Y [iterative reweighting])
1/(Y*Y) (weight by 1/observed Y2)
1(Yhat*Yhat) (weight by 1/predicted Y2 [iterative reweighting])

If oral reference formulation and data type is selected in the Formulation Information area, then the 
Include Time Lag and Strip Ka checkboxes are made available.

• Check the Time Lag checkbox to include a lag time parameter in the UIR model.

• Check the Strip Ka checkbox to generate the polyexponential describing the IV bolus pharmaco-
kinetics. This assumes that absorption is truly first-order, fits a model that is n-compartment poly-
exponential, and convolved with first-order absorption. The absorption is mathematically
separated from the decay. If this option is not selected, then the UIR is a polyexponential model of
the reference data.

• Check the Use Observed Times for Deconvolution checkbox to create deconvolved data
points (fraction absorbed) only at the times at which observations are recorded in the In Vivo
dataset. If left unselected, the deconvolution output includes the number of points specified in the
Options tab, listed from initial to final observed sample times.

Formulation information area

In this area, users can select the reference formulation and data type.

• Reference Formulation menu: Select the formulation identifier to be used in computing the UIR
and in building IVIVC models. The reference formulation must use all oral, IV bolus or IV infusion
input. The IVIVC object does not support combinations of inputs for UIR calculation.

• Reference Data Type menu: Select whether the reference input is oral, IV bolus or IV infusion.
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• In the Dosing Units field, type the dosing units to use with the PK data or click the […] button to
use the Units Builder dialog to add dosing units.

Caution: If you are using an external worksheet for the InVivo dosing data, make sure to map the worksheet 
before using the Dosing Units field. If you enter a unit in the field first that is different from the one 
in the worksheet, the unit used for the Prediction Dosing data will not get updated correctly. If this 
happens you will need to re-enter the information in the Prediction Dosing internal worksheet.

See “Using the Units Builder” for more details on this tool.

InVivo Data Options area

In this area, users can choose from three averaging options for observed, or InVivo, data.

• Generate mean profiles (validate against mean profiles): The default option and the one that 
is an accepted approach in regulatory review. When the InVivo dataset contains multiple 
subjects per formulation selecting this option creates a mean profile for each formulation. The 
mean profile is used for validation purposes, but is not used for model building.

• In the Averaging menu, select Mean to generate arithmetic means or GeoMean to generate 
geometric means.

Note: Changing the averaging method used to validate mean profiles affects the Generate UIR, Validate 
Correlation and Predict PK processes. It does not affect the Deconvolution or Build Correlation 
processes, because the mean profile is only used for validation.

• Do not generate mean profiles (validate against individuals’ profiles): With this option, the 
AUClast and Cmax values over the predicted and observed individual profiles are averaged and 
then the %PE is calculated based on those averages. This averaging option is not an accepted 
approach in regulatory review, however it could be useful when performing exploratory analysis 
or model building.

• Data already deconvolved and averaged: If the selected input dataset has already been 
decon-volved and averaged, choose this option to have Phoenix skip these steps. No UIR 
generation, deconvolution, or averaging is performed on the input dataset when the this option is 
selected. Data that is already deconvolved and averaged is validated against individual profiles.

Note: If this option is selected, then sort keys such as subject or study ID must be included in the data-
sets mapped to the InVivo Data and UIR panels, even if only mean data is used. If no sort column 
exists in those datasets, users must add a sort column. The sort column must contain the UIR 
parameters that are used with the corresponding plasma profile. For example, if only one UIR 
function is used for all formulations, then a sort column containing the parameter A1 must be 
added to the InVivo and UIR datasets.

Selecting Data already deconvolved and averaged causes the following four actions to occur:

• Phoenix displays a message warning users that any current deconvolution output in the
IVIVC project will be removed:

• Two new panels, UIR and InVivo Fit, are made available in the Setup tab. For instructions on
using the UIR and InVivo Fit panels, see “UIR panel” and “InVivo Fit panel”.

• All of the Unit Impulse Response options are made unavailable to the user.

• The Vivo.Fa_Avg and Vivo.Fa_Avg By Profile plots are not created. If they already exist in the
IVIVC results, they are removed.
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Note: If any IVIVC operations are dependent on deconvolved and averaged data, and the averaging 
option is changed, then the IVIVC process that contains the dependent operation turns yellow in 
the Status Panel.

Changing any of the In Vivo Data options after the Validate Correlation step is performed, results in a 
message to warn users that mean profile information will be removed from the project:

Generating UIR function and deconvolving data

• When all InVivo tab settings are ready, click Generate UIR to fit the unit impulse response func-
tion(s) and generate the InVivo worksheet and plot results.

Note: If the UIR step should fail due to incorrect column mappings (for example, the Sort and Values col-
umn were inadvertently switched), the Validate Correlation and Predict PK steps will continue to 
fail, even after the InVivo Data mappings are corrected. Make a copy of the InVivo dataset, add a 
prefix to all of the column names (e.g., change the “Time” column to “XTime”), then map this data-
set to the InVivo Data setup and map columns appropriately. The Validate Correlation and Predict 
PK steps will now execute successfully

• When UIR generation is complete, click OK in the completion dialog.

• Click Deconvolve to compute the fraction absorbed over time and to perform numeric deconvolu-
tion.

• When deconvolution is complete, click OK in the completion dialog.

The IVIVC object uses the subject and formulation sort keys specified to determine individual pro-
files to deconvolve, using the dosing information and the UIRs just generated. It generates esti-
mates for the fraction absorbed at 101 (default value) time points as specified in the Option tab,
unless the Use Observed Times for Deconvolution checkbox is selected.

Note: If users have already determined the UIR and (average) Fraction Absorbed, then all InVivo set-
tings must still be specified in order to generate the correct output.

• Select the Data already deconvolved and averaged option button in the In Vivo Data Options
area to skip UIR generation and deconvolution.

UIR panel

This panel is only available if Data already deconvolved and averaged is selected in the InVivo tab. 
Users should map a worksheet that contains the UIR polyexponential parameters in a stacked format 
to use with the IVIVC object. Required input is highlighted orange in the interface.

None: Data types mapped to this context are not included in any analysis or output.
Sort: The same sort columns used in the InVivo dataset. The sort columns identify unique individ-
uals.
InVivo Formulation: Drug formulation identifiers.
Parameter: IVIVC model parameters for each formulation.
Estimate: Estimated parameter values.
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InVivo Fit panel

This panel is only available if Data already deconvolved and averaged is selected in the InVivo tab. 
In the InVivo Fit panel, map a dataset that contains the mean deconvolved absorption profiles for 
each formulation in a stacked format. Required input is highlighted orange in the interface.

None: Data types mapped to this context are not included in any analysis or output.
InVivo Formulation: Drug formulation identifiers.
Independent: Sampling time values.
Mean: Mean deconvolved absorption data.

Correlation panels and tab

The Correlation tab and Correlation Estimates panel support the creation and validation of an InVitro-
InVivo correlation model for the dissolution data mapped to the InVitro Data panel, and the absorption 
data that is either generated from the deconvolution step in the InVivo tab or is mapped to the InVivo 
Fit panel.

The correlation is built using the formulations identified as Internal in the InVitro Formulation tab. The 
IVIVC object fits the selected correlation model to absorption data using the dissolution profiles from 
the InVitro Data panel as inputs to the correlation function.

To validate the correlation, Phoenix can estimate AUCs and maximum concentrations based on the 
model predictions, and compare the estimates to actual values from the InVivo data.

To perform the estimations and comparison, Phoenix convolves predicted fractions absorbed and 
UIRs, then runs noncompartmental analysis on the predicted PK data and the observed InVivo data.

Correlation Estimates panel
Plot Values panel
Correlation tab

Correlation Estimates panel

In the Correlation Estimates panel, enter the initial values or lower and upper boundaries for the 
model parameters. 

See “Correlation tab” for instructions on setting correlation model parameter options.

Depending on the selections made in the Correlation tab, context associations for Correlation Esti-
mates can include the following. Required input is highlighted orange in the interface.

None: Data types mapped to this context are not included in any analysis or output.
Parameter: Correlation model parameters.
Initial: Initial estimates for the parameter.
Lower: Lower boundary used for parameter estimates.
Upper: Upper boundary used for parameter estimates.

Plot Values panel

The values entered in the Plot Values panel apply only to the Tvivo vs. Tvivo plot (Levy.Tvivo vs Tvitro 
in the results). This plot is created by selecting the Tvivo vs. Tvitro (Levy) option in the Correlation tab. 
The Tvivo vs. Tvitro plot finds the times for dissolution and absorption for a matching fraction of disso-
lution and absorption. The absorption and dissolution values used to match the time values can be 
entered in the Plot Values panel. The default values are zero to one, incremented by 0.1. Users can 
change the default values if needed. Required input is highlighted orange in the interface.
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None: Data types mapped to this context are not included in any analysis or output.
Interpolation Values: Interpolation values used to plot InVivo and InVitro time values at specified 
intervals.

Correlation tab

The Correlation tab allows users to select the correlation model to use to fit fraction absorbed (Fabs).

Correlation area 

• Select the correlation model to use to fit the fraction absorbed (Fabs).

Fabs=Diss(Tvivo) 
Fabs=AbsScale*Diss(Tscale*Tvivo) 
Fabs=AbsScale*Diss(Tscale*Tvivo – Tshift) 
Fabs=AbsScale*(Diss(Tscale*Tvivo – Tshift) – AbsBase) 

• Select the User Specified option button to create a custom correlation model using the ASCII 
modeling language.

If the User Specified option button is selected, then the Correlation.Correlation.WNL ASCII For-
mat panel is made available in the Setup tab. Users can write a correlation model using the ASCII 
modeling language in this panel.

• If a user-specified correlation is used, click Check Syntax to verify the ASCII code.

• In the # parameters menu, select the number of model parameters.

• In the Tcutoff field (optional), enter the in vivo time at which the dissolution and absorption will 
stop increasing. That is, for the built-in models for Correlation, enter “Tvivo” at which the “Diss” 
function stops increasing and, therefore, the “Fabs” function also stops increasing. In other 
words, if Tvivo > Tcutoff, then Diss (Tvivo)=Diss(Tcutoff) and Fabs(Tvivo)=Fabs(Tcutoff).

• Specify initial value options for correlation model parameters.

• Select User Supplied Initial Parameter Values to enter initial parameter estimates in the 
Correlation Estimates panel.

• Select WinNonlin Generated Initial Parameter Values to have Phoenix determine the initial 
parameter values.

• Specify boundary options for correlation model parameters.

• Select User Supplied Bounds to enter lower and upper bounds for each parameter esti-
mate. Enter the boundary values in the Lower and Upper columns in the Correlation Esti-
mates panel.

• Select Phoenix bounds to have Phoenix generate the lower and upper bounds for each 
parameter.

• Select Do Not Use Bounds to not apply lower or upper boundaries to parameter estimates.
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• Click Build Correlation to run the correlation model.

• When correlation modeling is complete, click OK in the completion dialog.

Validation area

• Select the type of area under the curve to compute in the validation process from the AUC menu.

AUClast: dose time through the last positive concentration value (AUClast).
AUCall: from dose time through the final observation time (AUCall).
AUCINF_obs: AUClast+Clast/Lambda Z, where Clast is the last observed concentration (AUCIN-
F_obs).
AUCINF_pred: AUClast+Clast/Lambda Z, where Clast is the last predicted concentration (AUC-
INF).

• In the Calculation Method menu, select an AUC calculation method.

The selected calculation method applies to AUC computations. All methods reduce to the log
trapezoidal rule, the linear trapezoidal rule, or both. See “Partial area calculation” for descriptive
equations of the calculation methods. Note that the interpolation options of the AUC calculation
methods have no bearing on the validation calculations because partial areas are not computed.

• Linear_Log_Trapezoidal: Uses the log trapezoidal rule after Cmax, or after C0 for IV bolus if
C0 > Cmax. Otherwise the linear trapezoidal rule is used. If Cmax is not unique, then the first
maximum is used. This method uses linear trapezoids before Tmax and log trapezoids after
Tmax.

• Linear_Trapezoidal_Linear_Interpolation: Applies the linear trapezoidal rule to each pair of
consecutive points in the dataset that have non-missing values, and sums up these areas.
This method uses linear trapezoids before and after Tmax.

• Linear_Up_Log_Down: The linear trapezoidal rule is used any time that the concentration
data is increasing, and the logarithmic trapezoidal rule is used any time that the concentration
data is decreasing. This method uses linear trapezoids up and logarithmic trapezoids down
before Tmax and linear trapezoids up and logarithmic trapezoids down after Tmax.

Note: The Linear_Log_Trapezoidal and Linear_Up_Log_Down methods apply the same exceptions 
in area calculation. If a Y value (concentration, rate, or effect) is less than or equal to zero, Phoenix 
defaults to the linear trapezoidal rule for that point. If adjacent Y values are equal to each other, 
Phoenix defaults to the linear trapezoidal rule. 

• In the Averaging menu, select Mean to generate arithmetic means or GeoMean to generate geo-
metric means.

• Click Validation Correlation to generate a table of prediction errors for AUC and Cmax:

• When correlation validation is complete, click OK in the completion dialog.

A worksheet called Validation.Validation Errors is created in the Results tab that contains prediction 
errors for AUC and Cmax. The %PE column in the Validation.Validation Errors worksheet represents 
the prediction error percentage.

• Prediction error percentage is calculated as %PE (prediction error)=(Predicted-Observed)
/ Observed x 100%.

• For the Avg Internal formulation, the average is taken over the absolute values of PE for the
formulations specified as Internal.

Plots area 

Two diagnostic plots can be generated that can help with selecting a correlation model. Select the 
checkbox beside a plot to include it in the results. To see a final correlation plot rather than a prelimi-
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nary diagnostic plot, view the Correlation.Abs vs Diss.Corr Overlay plot after completing the Build 
Correlation step.

• Check the Tvivo vs. Tvitro (Levy) checkbox to include a Levy plot of in-vitro versus in-vivo times
for a given fraction that is absorbed or dissolved (Levy Plot.Tvivo vs Tvitro).

• Check the Fabs vs. Fdiss checkbox to include a plot of fraction absorbed vs. fraction dissolved
at corresponding times, sorted by formulation (Levy Plots.Fabs vs Fdiss).

• Click Generate Plots to create the plots.

• When the plots are generated, click OK in the completion dialog.

The default for the regression line in the Levy Plot is to fix the intercept at the origin. To calculate the 
intercept, do the following:

• From the Results tab, double-click the Levy Plot to display it as a separate window.

• In the tree view, select Graphs > Levy Plot > Regression.

• Unselect the Fix intercept at origin checkbox.

Prediction panels and tab

Prediction Data panel
Prediction Dosing panel
Prediction Estimates panel
Prediction tab

Prediction Data panel

Select the dataset that contains the percent dissolution data, as a fraction dissolved over time, and 
the corresponding time points and formulation identifiers. Required input is highlighted orange in the 
interface.

None: Data types mapped to this context are not included in any analysis or output.
Time: Predicted sampling time values.
Dissolution: Dissolution data.
Formulation: Formulation identifiers.

Note: Be sure to complete mapping of Prediction Data prior to mapping external worksheet data to Pre-
diction Estimates. Otherwise, the validation fails.

Note: In cases where a prediction has been partially set up at one time and then removed, the IVIVC 
object will appear as being out-of-date, even though there is no Prediction output yet.

Prediction Dosing panel

The Prediction Dosing panel allows users to specify dosing options for the test formulation. Required 
input is highlighted orange in the interface.

None: Data types mapped to this context are not included in any analysis or output.
Prediction Dose: Dose amount used in the prediction.
Prediction Formulation: Test formulation from the prediction data.
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Caution: If you are using an external worksheet for the InVivo dosing data, make sure to map the worksheet 
before using the Dosing Units field. If you enter a unit in the field first that is different from the one 
in the worksheet, the unit used for the Prediction Dosing data will not get updated correctly. If this 
happens you will need to re-enter the information in the Prediction Dosing internal worksheet.

Prediction Estimates panel

The Prediction Estimates panel allows users to specify initial estimates and lower and upper boundar-
ies for test formulation parameters. Users can also specify whether a parameter is fixed or estimated. 
See “Prediction tab” for initial value, and lower and upper bound options.

Depending on the model, users can fix certain parameters to known values. For example, the fraction 
dissolved, Finf, can be fixed to 1.0 to prevent incomplete measurements from biasing other parameter 
estimates. 

All iterative estimation procedures require initial estimates of the parameters. Phoenix can generate 
initial estimates for built-in models, or users can provide them. 

For IVIVC models only, some parameters can be assigned fixed values while others are estimated. 
The fixed command can be used for both modeling and simulating. Fixed parameters use a set value, 
so are no longer considered parameters. This reduces the number of parameters in the model. Statis-
tics such as VIF are not computed for fixed parameters.

Note: If the Prediction Estimates data source is an external worksheet, be sure to complete the mapping 
of Prediction Data prior to mapping Prediction Estimates. Otherwise, the validation fails.

Depending on the selections made in the Prediction tab, context associations for Prediction Estimates 
can include the following. Required input is highlighted orange in the interface.

None: Data types mapped to this context are not included in any analysis or output.
Sort: The test formulation names that are listed in the Prediction dataset. There can be multiple 
test formulations used as sort values. This mapping is required. Note that formulation names 
must be mapped to the Sort context.
Parameter: Test formulation parameters. 
Initial: Initial estimates for the parameter.
Fixed or Estimated: Whether or not the initial parameter is fixed or estimated.
Lower: Lower boundary used for parameter estimates.
Upper: Upper boundary used for parameter estimates.

Prediction tab

In order to provide smoothing, users can fit the dissolution data to a sigmoidal dissolution model. The 
Prediction tab generates a table of prediction errors for AUC and Cmax by comparing predicted data 
for test formulations mapped to the Prediction Data panel to the target formulation identified on the 
InVitro Formulation panel.
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The options available in this tab are the same as those in the InVitro tab (see “InVitro tab” for descrip-
tions), with the exception of the following:

Target Formulation: Select a target formulation to use as the comparator in predictions. Only 
one formulation can be selected in the menu.

Predict PK: Generate the prediction error worksheets. Worksheets are created for AUC, Cmax 
and other NCA parameters. This is done by comparing test formulations to the target formulation 
identified on the InVivo Formulation panel. Typical NCA output like final parameters and summary 
table worksheets are created in the Results tab.

Note: Even if a prediction is not being done, the Target Formulation should be set in order to use output 
from IVIVC downstream. If it is not set, it will prevent IVIVC from passing verification, which will 
prevent use of output in other objects.

Status tab

The Status tab lists whether or not modeling results were successful, and any errors in model option 
specifications. 
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Options tab

The Options tab allows users to specify model runtime options and the number of output points.

• In the Number of predicted values field, type the number of predicted values that are generated 
by IVIVC modeling operations.

• In the Number of iterations field, type the maximum number of iterations to use during model fit-
ting.

• In the Convolution Output Points field, type the number of output points to use in the convolu-
tion output.

• In the Deconvolution Output Points field, type the number of output points to use in the decon-
volution output.

Users can typically leave these options set to their default values.
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Results

Select the Results tab to view the output. IVIVC object output includes worksheets, plots, and text 
files. The lists of output in this section are grouped into tables based on the process by which they are 
generated.

Build correlation process output
Deconvolve data process and process output
Output for the fit dissolution step of Prediction
Output for InVitro stage of analysis
Output for Levy plot results of Percent absorbed vs percent dissolved
UIR Modeling output for InVivo stage
Predict PK process output
Validate correlation process output

Settings are not recorded on the History tab upon execution. However, they can be found in the indi-
vidual Settings text output files for the different steps.

Note: Word Export is not recommended for IVIVC as the export would include all internal/hidden steps 
whose results are not readily discernible to the user. 

Build correlation process output 

Worksheet 

Correlation.Abs vs Diss data: Fraction Absorbed vs Dissolved Data
Correlation.Correlation Overlay data: Fraction Absorbed vs Dissolved Overlay Data
Correlation.Correlation.*: Correlation Modeling Results
Correlation.Model Sim Vitro: Correlation Modeling Simulated Vitro Input
Correlation.Model Sim Vivo: Correlation Modeling Simulated Vivo Input
Correlation.Vitro Vivo Times: Used for in generating the Fraction Absorbed vs Dissolved plot. 
The tVitro added to Fa-Avg is based on the correlation function, all columns are removed except 
for formulation, tVivo, tVitro, and Mean

Plot 

Correlation.Abs vs Diss Corr Overlay: Fraction Absorbed vs Dissolved with Correlation Over-
lay data. This plot is generated for built-in models, but not for user models.
Correlation.Correlation.*: Correlation Modeling Results

Text File 

Correlation.Correlation.*: Correlation Modeling Results

Deconvolve data process and process output 

Worksheet 

Deconvolution Input: Input to the deconvolution step
Vivo.Deconvolution.Dosing: Deconvolution modeling output for InVivo stage of analysis
Vivo.Deconvolution.Exponential Terms: Deconvolution modeling output for InVivo stage of 
analysis
Vivo.Deconvolution.Fa-avg: Fa-Avg plot data
Vivo.Deconvolution.Fitted Values: Deconvolution modeling output for InVivo stage of analysis
Vivo.Deconvolution.Parameters: Deconvolution modeling output for InVivo stage of analysis
Vivo.Deconvolution.Values: Deconvolution modeling output for InVivo stage of analysis
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Plot 

Vivo.Deconvolution.Fa-Av: Fa-Avg overlaid. Average fraction absorbed by formulation. For the 
chart, Fabs grouped by subject with Fabs_avg overlaid and sorted by formulation. Not created if 
the Data already deconvolved and averaged option is selected, or if no sort variables are 
selected in the In-Vivo tab.
Vivo.Deconvolution.Fa-Av By Profile: Fa-Avg plot by profile. Fabs grouped by formulation, vs. 
time, and sorted by profile. Not created if the Data already deconvolved and averaged option is 
selected, or if no sort variables are selected in the In-Vivo tab.
Vivo.Deconvolution.Fitted Curves Plot: Deconvolution modeling output for InVivo stage of 
analysis
Vivo.Deconvolution.Input Rates Plot: Deconvolution modeling output for InVivo stage of analy-
sis

Text File 

Vivo.Deconvolution.Fa-avg: Descriptive Statistics settings for Fa-Avg
Vivo.Deconvolution.Settings: Deconvolution modeling output for InVivo stage of analysis

Output for the fit dissolution step of Prediction 

Worksheet 

Prediction.Diss.Condition Numbers
Prediction.Diss.Correlation Matrix
Prediction.Diss.Diagnostics
Prediction.Diss.Differential Equations
Prediction.Diss.Eigenvalues
Prediction.Diss.Final Parameters
Prediction.Diss.Final Parameters Pivoted
Prediction.Diss.Initial Estimates
Prediction.Diss.Minimization Process
Prediction.Diss.Partial Derivatives
Prediction.Diss.Predicted Data
Prediction.Diss.Secondary Parameters
Prediction.Diss.Secondary Parameters Pivoted
Prediction.Diss.Stacked Partial Derivatives
Prediction.Diss.Summary Table
Prediction.Diss.User Defined Settings
Prediction.Diss.VarianceCovariance Matrix 

Plot 

Prediction.Diss.Observed Y and Predicted Y vs X
Prediction.Diss.Partial Derivatives Plot
Prediction.Diss.Predicted Y vs Observed Y
Prediction.Diss.Predicted Y vs X
Prediction.Diss.Residual Y vs Predicted Y
Prediction.Diss.Residual Y vs X 

Text File 

Prediction.Diss.Core output
Prediction.Diss.Settings 

Output for InVitro stage of analysis 

Worksheet 

Vitro.Dissolution.Condition Numbers
Vitro.Dissolution.Correlation Matrix
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Vitro.Dissolution.Diagnostics
Vitro.Dissolution.Differential Equations
Vitro.Dissolution.Eigenvalues
Vitro.Dissolution.Final Parameters
Vitro.Dissolution.Final Parameters Pivoted
Vitro.Dissolution.Initial Estimates
Vitro.Dissolution.Minimization Process
Vitro.Dissolution.Partial Derivatives
Vitro.Dissolution.Predicted Data
Vitro.Dissolution.Secondary Parameters
Vitro.Dissolution.Secondary Parameters Pivoted
Vitro.Dissolution.Stacked Partial Derivatives
Vitro.Dissolution.Summary Table
Vitro.Dissolution.User Defined Settings
Vitro.Dissolution.VarianceCovariance Matrix 

Plot 

Vitro.Dissolution.Observed Y and Predicted Y vs X
Vitro.Dissolution.Partial Derivatives Plot
Vitro.Dissolution.Predicted Y vs Observed Y
Vitro.Dissolution.Predicted Y vs X
Vitro.Dissolution.Residual Y vs Predicted Y
Vitro.Dissolution.Residual Y vs X
Vivo.Deconvolution.Cumulative Input Plot 

Text File 

Vitro.Dissolution.Core output
Vitro.Dissolution.Settings 

Output for Levy plot results of Percent absorbed vs percent dissolved 

Worksheet 

Levy Plots.%Abs vs %Diss.Levy Plot Values
Levy Plots.%Abs vs %Diss.Parameters
Levy Plots.Fabs vs Fdiss.Levy Plot Values
Levy Plots.Fabs vs Fdiss.Parameters 

Plot 

Levy Plots.%Abs vs %Diss
Levy Plots.Fabs vs Fdiss 

UIR Modeling output for InVivo stage 

Worksheet 

Vivo.UIR.Condition Numbers
Vivo.UIR.Correlation Matrix
Vivo.UIR.Diagnostics
Vivo.UIR.Differential Equations
Vivo.UIR.Dosing Used
Vivo.UIR.Eigenvalues
Vivo.UIR.Final Parameters
Vivo.UIR.Final Parameters Pivoted
Vivo.UIR.Initial Estimates
Vivo.UIR.Minimization Process
Vivo.UIR.Partial Derivatives
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Vivo.UIR.Predicted Data
Vivo.UIR.Secondary Parameters
Vivo.UIR.Secondary Parameters Pivoted
Vivo.UIR.Stacked Partial Derivatives
Vivo.UIR.Summary Table
Vivo.UIR.User Defined Settings
Vivo.UIR.VarianceCovariance Matrix 

Plot 

Vivo.UIR.Observed Y and Predicted Y vs X
Vivo.UIR.Partial Derivatives Plot
Vivo.UIR.Predicted Y vs Observed Y
Vivo.UIR.Predicted Y vs X
Vivo.UIR.Residual Y vs Predicted Y
Vivo.UIR.Residual Y vs X 

Test File 

Vivo.UIR.Core output
Vivo.UIR.Settings
Vivo.UIR.Warnings and Errors 

Predict PK process output 

Prediction.Baseline Stats: Observed summary stats used to calculate the errors
Prediction.Conv.Results: Simulation Convolution modeling output for Prediction Stage
Prediction.Corr Sim.*: Correlation modeling simulation output for Prediction step
Prediction.Model Sim *: Vitro/Vivo data used for Correlation Simulation
Prediction.Observed Baseline Nca.*: Observed NCA results
Prediction.Predicted Nca prediction.*: Predicted NCA results
Prediction.Predicted Stats: Predicted summary stats used to calculate the errors
Prediction.Prediction Errors: Prediction Errors

Validate correlation process output 

Worksheet 

Validation.Average Vivo.Statistics: Validation summary stats used to calculate the errors
Validation.Avg PE Stats: Validation percent error calculations
Validation.Baseline Stats: Observed summary stats used to calculate Validation errors
Validation.Conv.*: Simulation Convolution modeling output for Validation Stage
Validation.Corr Sim.*: Simulation Correlation modeling output for Validation Stage
Validation.Model Sim *: Correlation model simulation Vitro/Vivo input for Validation Stage
Validation.Observed Baseline Nca.*: Observed NCA analysis for Validation Stage
Validation.Predicted PK Nca.*: Predicted NCA analysis for Validation Stage
Validation.Predicted Stats: Predicted summary stats used to calculate Validation errors
Validation.Validation Errors: Validation Errors

Plot 

Validation.Corr Sim.*: Simulation Correlation modeling output for Validation Stage
Validation.Observed Baseline Nca.Observed Y and Predicted Y vs X: Observed NCA analy-
sis for Validation Stage
Validation.Predicted PK Nca.Observed Y and Predicted Y vs X: Predicted NCA analysis for 
Validation Stage
Validation.Val Conv Out: Convolution results for simulation part of Validation 
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Text File 

Validation.Baseline Stats: Observed summary stats settings used to calculate Validation errors
Validation.Conv.Settings: Simulation Convolution modeling output for Validation Stage
Validation.Corr Sim.*: Simulation Correlation modeling output for Validation Stage
Validation.IVIVC.Validation: Settings for the filter prior to generation of Validation Errors
Validation.Observed Baseline Nca.*: Observed NCA analysis for Validation Stage
Validation.Predicted PK Nca.*: Predicted NCA analysis for Validation Stage
Validation.Settings: Validation settings

Sigmoidal and Dissolution models

Model 601 — Hill
Model 602 — Weibull
Model 603 — Double Weibull
Model 604 — Makoid-Banakar
ASCII user model for correlations

Model 601 — Hill

Finf: amount released at time infinity, using the preferred units for y 
MDT: mean dissolution time, in the preferred units for x (time)
b: slope factor (no units)
int: y-intersect; zero (default) or first positive y value in data if estimated, with bounds of zero and 
10 times that value

Finf: amount released at time infinity, using the preferred units for y 
MDT: mean dissolution time, in the preferred units of x (time)
b: slope factor (no units)

 y(t) = int + ((Finf – int)  tb)/(MDTb + tb)

where the estimated parameters are:

This model includes an optional lag time in the form of a step function, i.e.:

y(t) = int + ((Finf – int) U(t – tlag)b)/(MDTb + U(t – tlag)b)

where U(x) = x if x >= 0; U(x) = 0 if x < 0. 

Model 602 — Weibull

 y(t) = int + ((Finf – int)(1 – exp[–(t/MDT)b])

where the estimated parameters are:
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int: y-intersect; zero (default) or first positive y value in data if estimated, with bounds of zero and 
10 times that value

f1: weighting factor, setting the fraction due to each Weibull (no units)
Finf: amount released at time infinity, using the preferred units for y 
MDT1, MDT2: mean dissolution time for each Weibull, (x units)
b1, b2: slope factors (no units)
int: y-intersect; zero (default) or first positive y value in data if estimated, with bounds of zero and 
10 times that value

This model includes an optional lag time in the form of a step function, i.e.:


for t <= Tmax 

Fmax: maximum y value, using the preferred units for y 
Tmax: time of maximum y value, using the preferred units for x (time)
b: slope factor (no units)
int: y-intersect; zero (default) or first positive y value in data if estimated, with bounds of zero and 
10 times that value

This model includes an optional lag time in the form of a step function, i.e.:

y(t) = int + ((Finf – int)(1 – exp[–(U(t – tlag)/MDT)b])

where U(x) = x if x >= 0; U(x) = 0 if x < 0. 

Model 603 — Double Weibull

 y(t) = int + f1  (Finf – int)  (1 – exp[–(t/MDT1)b1]) +

(1 – f1)  (Finf – int)  (1 – exp[–(t/MDT2)b2])

where the estimated parameters are:

y(t) = int + f1  (Finf – int)  (1 – exp[–(U(t – tlag)/MDT1)b1])

+ (1 – f1)  (Finf – int)  (1 – exp[–(U(t – tlag)/MDT2)b2])

where U(x) = x if x >= 0; U(x) = 0 if x < 0. 

Model 604 — Makoid-Banakar

 y(t) = int + (Fmax – int)  (t/Tmax)b  exp[b (1 – t/Tmax)], 

y(t) = Fmax, for t > Tmax 
where the estimated parameters are:
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Note: The FMAX parameter can be fixed at a certain value by doing one of the following:
– Set the initial estimates option to User-Supplied Initial Parameter Values, and then set initial
estimates for any estimated parameters. 
– Create a worksheet and use it as an external worksheet for the initial estimates.

ASCII user model for correlations

A custom model for an IVIVC correlation needs to include only the parameter definitions and model 
equations. No other statements are required.

• In the # parameters menu in the Correlation tab, select the number of model parameters.

• In the Correlation Estimates panel, enter an initial value for each model parameter.

• Edit the statements in the Correlation Code panel to reflect the model. Use the ASCII model syn-
tax and the following keywords that are specific to IVIVC:

• IVINTERP(): This function is used to interpolate dissolution data. A common usage is for X to
be the in vivo time, and X is then scaled or shifted by model parameters to yield an in vitro
time, which is called T. IVINTERP is then used to interpolate the dissolution data to find the
dissolution at time T. The first and last values in the dissolution data are used when T is
respectively before or after the time range of the dissolution data.

• DOSEVIVO: This variable contains the dose amount for each formulation. The wizard will
translate this variable into the DTA array that is part of the modeling language.

Data deficiencies resulting in missing values for PK parameters

Phoenix reports missing values for PK parameters in the following cases:

Profile with no non-missing observations after dose time, Phoenix reports missing values for all 
final parameters.

Bolus dosing and <=1 non-missing observation after dose time, Phoenix reports missing values 
for all final parameters.

Blood/plasma data with no non-zero observation values, Phoenix reports missing values for all 
final parameters except: Cmax, AUClast, AUCall, AUMClast.

Blood/plasma data with all zero values except one non-zero value at dosing time, Phoenix reports 
missing values for all final parameters.

This model includes an optional lag time in the form of a step function, i.e.:

y(t) = int + (Fmax – int)  [U(t – tlag)/Tmax]b  exp[b  (1 – U(t – tlag)/Tmax)]

where U(x) = x if x >= 0; U(x) = 0 if x < 0.
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IVIVC workflow example

This example steps through the full process of using the Phoenix IVIVC workflow to generate an in 
vitro in vivo correlation model and apply it to predict PK profiles from dissolution data for a new for-
mulation.

The completed project (IVIVC_Workflow.phxproj) is available for reference in …\Exam-
ples\IVIVC. 

Note: Phoenix IVIVC functionality requires a license for the Phoenix IVIVC Toolkit.

Set up the project and data

1. Create a new project named IVIVC_Workflow.

2. Import the following files from …\Examples\IVIVC\Supporting files
In the File Import Wizard dialog, check the Has units row checkbox for each file.
Click Finish.

IVIVC_Diss.csv: in vitro fraction dissolved over time for five formulations.

IVIVC_Test.csv: time-concentration profiles for individual subjects given the same formula-
tions in IVIVC_Diss.csv.

IVIVC_Vivo_Subj.csv: in vitro fraction dissolved over time for a new, test formulation, for
use in predicting PK data.

Select and smooth the dissolution data

The IVIVC object's InVitro Data panel, InVitro Formulation panel, and InVitro tab (located underneath 
the Setup tab) include settings to identify the dissolution data to be used in fitting an in vitro in vivo 
correlation, and settings to smooth the dissolution data.

1. Select Workflow in the Object Browser and then select Insert > IVIVC > IVIVC.

2. Drag the IVIVC_Diss dataset from the Data folder to the InVitro Data Mappings panel to map it as
the input source.

3. Map the data types to the following contexts:
Map Time to the InVitro Time context.
Map Formulation to the InVitro Formulation context.
Map Fdiss to the InVitro Dissolution context.

4. Select InVitro Formulation from the Setup list and map the data types as follows:
Map CR01, CR02, and CR04 to the Internal context. These formulations are used to fit the IVIVC.
Map CR03 to the External context. It is used to validate the IVIVC in the Correlation tab.
Leave Targ mapped to None. The target formulation provides the comparator for predictions made
in the Prediction tab.

Note: Mapping the Formulation Partitioning dataset enables users to perform dissolution data partition-
ing, which identifies the formulations that are used for IVIVC fitting and testing.

5. In the InVitro tab, below the Setup tab, select the Weibull option button under Dissolution Model.

6. Select InVitro Estimates in the Setup list.

7. For the FINF (fraction absorbed extrapolated to time infinity) parameter for each formulation,
select Fixed in the Fixed or Estimated column to set its initial value.
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8. Enter 1 in the Initial column for the FINF parameter for each formulation.

9. Enter 0 in the Initial column for the TLAG and INT parameters for each formulation, if necessary.

10. In the InVitro tab click Fit Dissolution Data to fit the Weibull model and generate smoothed data
for each subject.

11. When the model fit and data smoothing are complete, click OK in the completion dialog.

Fit the unit impulse response and estimate absorption

The IVIVC object InVivo Data panel and InVivo tab support identification of in vivo PK data, support 
fitting of the unit impulse response (UIR) function, and provide an estimation of the fraction of drug 
absorbed over time based on the UIR and PK data.

1. In the Setup list, select InVivo Data.

2. Drag the IVIVC_Vivo_Subj worksheet from the Data folder to the InVivo Data Mappings panel.
Map Time to the Independent context.
Map Subj to the Sort context.
Map Form to the InVivo Formulation context.
Map Cp to the Values context.

3. Select the InVivo Dosing in the Setup list.

4. Set the dose for each formulation to a value of 1.

Look at the Status Panel in the lower right corner of the window. Note that the top three squares in
the panel are now green, indicating that those steps have been completed.

Figure 5-1. Status panel: completed steps have a green box and incomplete steps a red box

5. Select the InVivo tab, which is located below the Setup tab.

6. Leave the Maximum number of UIR exponentials menu set to 3.

7. Select IV in the Reference Formulation menu.

8. Click Generate UIR to fit the model and generate predicted data for each subject.

9. When the model fit and data generation are complete, click OK in the completion dialog.
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10. Click Deconvolve.

Phoenix deconvolves PK subject data with the newly fitted UIRs to estimate the fraction of the
drug absorbed over time for each subject.

11. When the deconvolution is complete, click OK in the completion dialog.

Select the Status tab, below the Setup tab, to see the status of each step of the IVIVC workflow. If
a step fails the Status tab displays information concerning why the step failed.

Figure 5-2. Status tab containing details about each step

Develop and validate the IVIVC model

Now that smoothed dissolution data and estimated absorption data are available, they can be used to 
fit and test a correlation model.

1. Select the Correlation tab, below the Setup tab.

2. Select the Fabs=AbsScale*Diss(Tscale*Tvivo) option button, if it is not selected.

3. Click Build Correlation.

Phoenix fits the model to the dissolution and absorption data and generates parameters and pre-
dicted data.

4. When the correlation is complete, click OK in the completion dialog. 

The Results tab displays the Correlation Step worksheets, plots, and text output.

5. In the Correlation tab, select Linear_Trapezoidal_Linear_Interpolation in the Calculation
Method menu, if it is not already selected.

6. Click Validate Correlation.

Phoenix performs a noncompartmental analysis on the predicted and observed PK data, averages
the AUC and Cmax for each formulation, and displays the percentage of error and the ratio of the
predicted to observed data as measures of prediction error.

7. When the correlation validation is complete, click OK in the completion dialog.

Predict PK

Once an acceptable IVIVC model is generated Phoenix can use it to predict PK data based on disso-
lution data for new formulations.

1. In the Setup list, select Prediction Data.
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2. Drag the IVIVC_Test worksheet from the Data folder to the Prediction Data Mappings panel.
Map Time to the Time context.
Map Formulation to the Formulation context.
Map Fdiss to the Dissolution context.

3. Identify which formulations will be used for IVIVC fit and testing by selecting Prediction Dosing in
the Setup list.

Note: If an internal worksheet relies on internal data sources, such as output from part of the IVIVC 
workflow, then the worksheet might not be displayed. 

4. Click Rebuild to create the internal worksheet.

5. Enter 1 in the Dose column.

6. In the Prediction tab, below the Setup tab, select the Weibull option button to choose the Weibull
dissolution model.

7. Select Prediction Estimates in the Setup list.

8. Select Fixed in the Fixed or Estimated column to set the initial value for the FINF parameter.

9. Enter 1 in the Initial column for the FINF parameter

10. In the Prediction tab, select Targ in the Target Formulation menu.

11. Click Fit Dissolution Data to fit the model and generate smoothed data.

12. When the model fit and data generation are complete, click OK in the completion dialog.

13. Click Predict PK in the Prediction tab to generate predicted PK data for each subject that exists in
the original dissolution and PK datasets.

14. When PK data prediction is complete, click OK in the completion dialog.

Phoenix uses the IVIVC model to predict absorption for each subject and then convolves that with the 
UIRs from the target formulation to generate PK data for each subject. Phoenix then performs non-
compartmental analysis on the predicted data and compares the results to those for the target formu-
lation selected in the InVivo Data panel. The output, shown on the Results tab, gives the prediction 
error versus the target formulation. The IVIVC workflow is complete when Predict PK in the Status 
Panel is green. The output, shown on the Results tab, gives the prediction error versus the target for-
mulation. 

Note: It is not necessary to click the Execute button. Because the IVIVC object is a series of workflows 
clicking the Execute button will only re-execute all the steps that have been completed, and not 
produce any new output.

This concludes the IVIVC Workflow example.
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Levy Plot

Levy plots compare InVivo absorption and InVitro dissolution data visually, as time-versus-time plots 
at matched values for absorption and dissolution. The plots include a linear fit of the data points with 

intersection at origin, and the correlation (R2) value and the slope for the model line, as well as a line 
at unity.

Levy plots require two separate datasets, one containing InVivo and the other containing InVitro data. 
Phoenix uses these datasets to plot InVivo versus InVitro times at user-specified Y values (typically, 
fraction absorbed or dissolved), using linear interpolation to calculate data points as needed. Matched 
time pairs are sampled from the data within the range from zero to the maximum observed dissolution 
or deconvolved absorption value, whichever is smaller.

The InVivo and InVitro datasets can contain the same or different sort variables. If sort variables with 
identical column names are in both datasets, then Phoenix includes only the sorting values that exist 
in both datasets. For non-matching sort variables, Phoenix uses the cross-product of the sort values 
to create the plots.

If units are used with the dataset variables mapped to the Values contexts, then the units must match 
in the InVivo and InVitro datasets.

The Levy Plot object groups data by formulation for each plot. Each formulation is displayed in a dif-
ferent color and is listed in the plot legend. The Levy Plot object uses only those formulation values 
that are in both datasets.

If a Y value to be plotted exists in the dataset, Phoenix uses the data. Otherwise, all other values are 
computed using simple linear interpolation. Data for formulation values that exist in only one dataset 
are not displayed in the plot or worksheet output. If no formulation values match in either dataset, then 
no output is created.

Note: The summary line on each Levy plot is fit to all matching formulations.

Use one of the following to add the object to a Workflow:

Right-click menu for a Workflow object: New > IVIVC > LevyPlot. 
Main menu: Insert > IVIVC > Levy Plot.
Right-click menu for a worksheet: Send To > IVIVC > LevyPlot.

Note: To view the object in its own window, select it in the Object Browser and double-click it or press 
ENTER. All instructions for setting up and execution are the same whether the object is viewed in 
its own window or in Phoenix view.

This section contains the following topics:

InVitro and InVivo panels
Match Values panel
Options tab
Plots tab
Results

InVitro and InVivo panels

Use the Main Mappings panel to identify how input variables are used in a LevyPlot object. Required 
input is highlighted orange in the interface.
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None: Data types mapped to this context are not included in any analysis or output.
Sort: Individual profiles used to sort the output into separate plots. 
Independent: Sampling time values.
Values: Concentration sampling values, one value per sampling time per profile (see note below). 
Values from both datasets must have the same units.
Formulation: Drug formulation identifiers. Blank/empty formulation cells are not supported.

Caution: If the datasets both have a column named “Formulation,” these two columns will be used, even if 
they are not mapped in the panels. The Levy Plot will fail if the values in the two columns do not 
match.

Note: In cases where a profile has more than one value for a time point, use Descriptive Statistics on the 
source workbooks to average the values for each profile so that there is one value per time point. 
Then execute the Levy Plots object on the two Descriptive Statistics output. 

Match Values panel

Required input is highlighted orange in the interface.

None: Data types mapped to this context are not included in any analysis or output.
Formulation: Formulation data.
Interpolation Values: Interpolation values used to plot InVivo and InVitro time values at specified 
intervals.

Additional notes on match values

The Levy Plot object plots InVivo versus InVitro times corresponding to the Y values selected in the 
InVivo and InVitro panels. Match values are applied to all sort profiles, so there can be no missing or 
null values in the sort keys or an error is generated. The default interpolation values are zero to one, 
incremented by 0.1 for each sort profile. Users can also enter their own Y values to plot interpolated 
times using those values.

The InVivo dataset sampling time values are used for the Y-axis data. The match values must match 
the time units used in the InVivo dataset. For example, if sampling time is measured in hours, then the 
match values must correspond to the hourly sampling times. If sampling time is measured in days, 
then match values must correspond to the daily sampling times.

If an internal worksheet is used, the match values are applied to all profiles. If an external worksheet 
is used, users can map formulation data that uses different matched values for different formulations.

• In the Levy Plots, the first value is displayed at Y=0, then at the specified interval up to the end of 
the sample data range. For example, an interval value of 10 generates plot values at Y=0, 10, 20, 
30, etc. for the sampling time input data.

• If the same values are entered for each profile, then interpolated time values are plotted at regu-
lar intervals across the sample data. 

The maximum Y value displayed in the plot is the lesser of the maximum observed fraction dissolved 
and the calculated fraction absorbed. The Levy Plot object does not plot any points that are extrapo-
lated from one of the datasets.

Options tab

The Options tab allows users to specify how plot labels are displayed. 
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• Check the Use Independent Column Mappings Names for Plot Labels checkbox to use the
dataset variables mapped to the Independent contexts in the InVivo and InVitro panels as the plot
labels.

• In the Axis Labels area, enter any custom labels for the axes and legend.

• In the X Axis field, type a custom X-axis label.

• In the Y Axis field, type a custom Y-axis label.

• In the Legend Labels field, type a custom label for the plot legends.

• In the Match Values area, specify interpolated time value intervals and whether or not the inde-
pendent variable is fractional or a decimal.

The Plot Values at every checkbox is selected by default. This option creates a plot of interpo-
lated time values at regular intervals across the sample data.

Enter the interval value in the Plot Values at every field, or leave the default value. The first value
is displayed at Y=0, then at the specified interval until the end of the sample data range. For
example, an interval value of 10 generates plot values at Y=0, 10, 20, 30, and so forth until the
end of the data range is reached. The maximum Y value displayed is the lesser of the maximum
observed fraction dissolved and the calculated fraction absorbed.

The Datapoints are fractional checkbox is selected by default. Leave this option selected if the
data are expressed as fractions instead of percentages. Phoenix multiplies the values by 100
before plotting.

Note: To enter interpolation values manually, clear the Plot values at every checkbox in the Options tab, 
select a cell in the Values column (in the Mappings panel) and type the interpolation value. Con-
tinue selecting cells and entering values until all of the desired interpolation values are entered.

Plots tab

See the Plots tab description in the Loo Riegelman section. 

Results

The Levy Plot object creates one text file, one plot or group of plots, and two worksheets in the 
Results tab. The plot panel displays one levy plot for each individual profile. 

Worksheet 

• Levy Plot Values: Values used in the plots, including interpolated and original data values, where
interpolation was not necessary, including any sort variables. For each unique combination of sort
variable values, the plot output contains Formulation data, if included, Values, TVitro, and TVivo.
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• Parameters: Output from fitting model 502, including estimates and statistics for the Y-intercept
(INT) and slope.

Text File 

• Settings: User-defined settings.

Note: Word Export is not recommended for Levy Plots as the export would include all internal/hidden 
steps whose results are not readily discernible to the user. 

Users can double-click a plot in the Results tab to edit it. (See the menu options descriptions in the 
Plots chapter of the Data Tools and Plots Guide for plot editing options.) 

The default for the regression line in the Levy Plot is to fix the intercept at the origin. To calculate the 
intercept, do the following steps:

• From the Results tab, double-click the Levy Plot to display it as a separate window.

• In the tree view, select Graphs > Levy Plot > Regression.

• Clear the Fix intercept at origin checkbox.
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Loo-Riegelman

The Loo-Riegelman object is a two-compartment IV-bolus model that uses deconvolution to estimate 
the fraction of drug absorption. The model also generates AUCs (Areas Under the Curve) and rate of 
absorption values. This deconvolution model is best used to calculate the absorption kinetics of intra-
venously administered drugs.

For drugs that are administered through methods other than IV-bolus, such as oral or transdermal 
methods, it is preferable to use the Deconvolution object to evaluate drug release and absorption. For 
more information on the Deconvolution object, see “Deconvolution”.

Use one of the following to add the object to a Workflow:

Right-click menu for a Workflow object: New > IVIVC > Loo-Riegelman.
Main menu: Insert > IVIVC > Loo-Riegelman.
Right-click menu for a worksheet: Send To > IVIVC > Loo-Riegelman.

Note: To view the object in its own window, select it in the Object Browser and double-click it or press 
ENTER. All instructions for setting up and execution are the same whether the object is viewed in 
its own window or in Phoenix view.

This section contains the following topics:

Loo-Riegelman inputs and calculations
Main panel
Dosing panel
Slopes Selector panel
Slopes panel
Parameters panel
Options tab
Plots tab
Results

Loo-Riegelman inputs and calculations

Like Wagner-Nelson, the Loo-Riegelman method estimates the fraction of drug absorbed as a func-
tion of time, relative to the total amount to be absorbed, following the method described in Gibaldi and 
Perrier (1975) pages 136 to 142. It computes AUC values for each time point in the time-concentra-
tion dataset, as in Wagner-Nelson. For Loo-Riegelman, estimates for K10, K12, and K21 must be pro-
vided, as may be obtained by running Least-Squares Regression PK model 7 on separate IV data. 

Note: Loo-Riegelman computations assume single-dose PK data with a concentration value of zero at 
dose time. If no concentration value exists at dose time, a value of zero is used.

The value of AUCINF (AUC) may be user-specified or can be computed as for non-compartmental 

analysis:

AUC=AUClast+Clast/Lambda_z

Either the observed or predicted value for Clast, where Clast_pred=exp(intercept – Lambda_ztlast) can 
be used. As in the Wagner-Nelson method, the method for computing Lambda Z is specified by the 
user: best fit, user-specified range, or user-specified value. An intercept for the last case can be 
entered by the user. If the intercept is not specified, it will be computed using the last positive concen-
tration and associated time value:
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intercept=Lambda_z  tlast+ln(Clast)

Note that the Loo-Riegelman method uses Lambda Z only to compute AUC; it uses the intercept 
only to compute Clast_pred.

The cumulative amount absorbed at time t, normalized by the central compartment volume V1, is:

Cumul_Amt_Abs_V(t)=Conc(t)+K10  AUC(t)+Amt_Peripheral_V(t)

The amount in the peripheral compartment at time t, normalized by V1, is computed sequentially as:

Amt_Peripheral_V(t)=(Prior_Amt_Peripheral_V)  exp(–K21t)
+ (K12  Prior_Conc/K21)  (1 – exp(–K21t)

+ (K12  t  Conc/2)5

See Gibaldi and Perrier (1975) pages 138–139 for the derivation of this equation.

Cumul_Amt_Abs_V at time infinity is:

Cumul_Amt_Abs_V(inf)=K10  AUC 

The fraction absorbed at time t is computed as:

Rel_Fraction_Abs(t)=Cumul_Amt_Abs_V(t)/Cumul_Amt_Abs_V(inf)

Data points with a missing value for either time or the concentration will be excluded from the analysis 
and will not appear in the output.

Main panel

Use the Main panel to identify how input variables are used in the object. Required input is highlighted 
orange in the interface.

None: Data types mapped to this context are not included in any analysis or output.
Sort: Categorical variable(s) identifying individual data profiles, such as subject ID.
Carry: Data variable(s) to include in the output worksheets.
X: Nominal or actual time collection points in a study.
Y: Drug concentration values from blood plasma.

Dosing panel

Note: If no concentration value exists at dose time for a given profile, Phoenix inserts a concentration 
value of zero at the specified dose time.

Note: The time units for the dosing data must be the same as the time units for the time/concentration 
data.

None: Data types mapped to this context are not included in any analysis or output.
Sort: Categorical variable(s) identifying individual data profiles, such as subject ID.
Time of Last Dose: Time of the last dose administration.



Loo-Riegelman

37

Dosing sorts dialog

The first time a user selects the Dosing panel Phoenix displays a dialog that prompts the user to 
select the sort variables to use to create the internal dosing worksheet. This dialog is only displayed if 
sort keys are selected.

The Dosing sorts dialog uses the sort variables specified in the Main Mappings panel. By default all 
sort variables are selected. 

• Click OK to accept the default sort variables.

• To select a subset of the sort variables, clear the checkbox beside the unwanted sort variable and 
click OK.

• To choose new sort variables, click Rebuild in the Dosing panel. The Dosing panel is cleared and 
the Dosing sorts dialog is displayed again.

Slopes Selector panel

Phoenix tries to estimate the rate constant Lambda Z, which is associated with the terminal elimina-
tion phase for concentration data. These measurements are estimated using the linear or the linear-
log trapezoidal rules, which are selected in the Calculation Method menu in the Options tab. If 
Lambda Z is estimable, parameters for concentration data are extrapolated to infinity. 

The following section contains usage instructions. For descriptions of how the Loo-Riegelman model 
determines Lambda Z or slope estimation settings, see “Lambda Z or Slope Estimation settings”.

If the observation data does not extend significantly into the terminal phase, then selecting Observed 
in the Area Under the Curve menu can cause the model to significantly underestimate the actual 
AUCINF. For example, if the absorption phase was not completed, then scaling errors can occur when 
Phoenix computes the fraction absorbed.

Define the Lambda Z or slope estimation settings:

• Select Slopes Selector in the Setup tab. 

The observed times for each profile are displayed on a graph. A graph for each profile is listed on 
separate tabs in the Slopes Selector panel.

• Use the View menu to select a linear (Lin) or logarithmic (Log) axis scale.

• Use the Lambda Z Calculation Method menu to select Best Fit, Time Range, or Parameters 
as the calculation method.

If Best Fit is selected, Phoenix calculates the points for Lambda Z estimation for each profile.

If Time Range is selected users must type the start and end times for Lambda Z estimation in the 
Start and End fields.
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If Parameters is selected users can type their own values in the Lambda Z and Intercept fields. 
Intercept values are optional, so if no intercept value is entered, Phoenix computes it as: inter-
cept = Lambda_z(tlast) + ln(Clast) 

Since no specific points are used in the Lambda Z computation, the Lambda Z output in the 
Results tab will contain predicted and residual values for all time and concentration values. Any 
start times, end times, Lambda Z values, and intercept values must be greater than zero.

• In the Area Under the Curve menu, select a method to use to calculate the AUC to time=infinity.

If Observed is selected, then Phoenix calculates the AUC as AUC=AUClast+Clast/Lambda_z, 
where Clast is the last observed concentration.

If Predicted is selected, then Phoenix calculates the area under the curve (AUC) as 
AUC=AUClast+Clast/Lambda_z, where Clast is the last predicted concentration.

If Specified is selected, then users can type a value for the AUC in the specified values field. The 
AUC value must be greater than zero.

Caution: If Specified is selected in the Area Under the Curve menu, then any user-specified Lambda Z 
Calculation Method settings are not applied to the Loo-Riegelman model results.

Set start times, end times, and exclusions:

Users can manually select start times, end times, and excluded time points by selecting them on each 
profile graph. 

Note: Manually selecting times and exclusions automatically sets the Lambda Z Calculation Method to 
Time Range.

• Left-click a data point on a graph to select the start time. 

• Press SHIFT and left-click a data point on a graph to select the end time.

• Press CTRL and left-click a data point on a graph to exclude the time point.

• Remove or change the start time, end time, and exclusions by selecting new points on the graph 
using the same mouse and keyboard commands listed in steps 1 through 3.

When the start time, end time, and exclusions are manually selected, the graph title is updated to 

show the new R2 calculation, the graph is updated to show the new slope, and the legend is updated 
to show the new slope and exclusions, as shown below.
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Figure 7-1. Manually selected start, end, and excluded time points for the first profile

Note: Excluded data points apply only to Lambda Z or slope calculations. The excluded data points are 
still included in the computation of AUCs, moments, etc.

Slopes panel

In the Slopes panel, users can enter the start times, end times, and exclusions used to calculate the 
Lambda Z for each profile defined in the Slopes panel. Users can also enter AUC values, select the 

AUC computation method, enter Lambda Z and intercept values, and select the Lambda Z calculation 
method.

Users can type their own values and select calculation methods in the Slopes panel. The following 
section contains usage instructions. For descriptions of how the Loo-Riegelman model determines 
Lambda Z or slope estimation settings, see “Lambda Z or Slope Estimation settings”.

Define slopes and select calculation methods:

• Select Slopes in the Setup tab.

• Type the start and end time values in the Start Time and End Time columns for each profile.
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• Type excluded time points in the Exclusions column for each profile. 
Exclude multiple time points for a profile by typing the time points in the same cell and separating 
the time points with a semicolon.

• Type user-specified AUC values in the AUCINF column. The value must be greater than zero.

• Select an AUC calculation method in the AUC Method column.

• Type Lambda Z values in the LambdaZ column.

• Type slope intercept values in the *Intercept column.

Slope intercept values are optional. If no intercept value is entered, Phoenix computes it as: 
intercept = Lambda_z(tlast) + ln(Clast) 

• Select a Lambda Z calculation method in the Fit Method column.

Apply slope and calculation settings to multiple profiles:

• Type the desired start and end times, exclusions, and other values and select the calculation 
methods for the first profile or profile group.

• When all changes are made, use the pointer to highlight all the rows for every column between 
Start Time and Fit Method columns for the first profile or profile group.

• Place the pointer over the black square on the lower right side of the selection. The pointer 
changes to the following shape. This signifies that the drag and fill feature can be used. 

• Press the left mouse button and drag the selection down to fill the InVitro Estimates cells beside 
each formulation.

Use the following instructions to copy the same settings from one profile to another.

• Enter all necessary values and select the calculation methods for a profile.

• Use the pointer to highlight the entire row.

• The pointer changes to the following shape. This signifies that the drag feature can be used.

• Press the left mouse button to drag the target row of slope settings to the destination row.

Example column headings for Slopes table:

Sort variable(s): Categorical variable(s) identifying individual data profiles, such as subject ID. 
Selected sort variables in the Main Mappings panel are used as default column headings. In the 
previous image, Subj is the sort variable.
Start Time: Users must type times for Lambda Z estimation in the Start and End fields.
End Time: Users must type the times for Lambda Z estimation in the Start and End fields.
Exclusions: Excluded data points in the plots.
AUCINF: User-specified AUCINF values. The values must be greater than zero.
AUC Method: Select a method to use to calculate the AUC to time=infinity.
LambdaZ: Users can type their own values in the LambdaZ and Intercept fields. Intercept val-
ues are optional, so if no intercept value is entered, Phoenix computes it as: intercept = Lamb-
da_z(tlast) + ln(Clast)
Intercept: Y-intercept value. Entering this value is optional.
Fit Method: Select Best Fit, Time Range, or Parameters as the Lambda Z calculation method.
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Parameters panel

The Loo-Riegelman method requires initial estimates for the model parameters describing the two-
compartment model that fits the IV data. Parameter estimates can be obtained by using PK model 7 to 
evaluate the data prior to using the Loo-Riegelman object. The use external worksheet option is 
selected by default in the Parameters panel. All K (fractional rate constant) values must be greater 
than zero.

None: Data types mapped to this context are not included in any analysis or output.
Subj/Sort: Categorical variable(s) identifying individual data profiles, such as subject ID. The sort 
variables selected in the Main Mappings panel are used as default column headings.
K10: Fractional rate constant for the central compartment.
K12: Fractional rate constant for the flow between the central compartment and a peripheral com-
partment.
K21: Fractional rate constant for the flow between the peripheral compartment and a central com-
partment.

Use the Rebuild button to reset the internal worksheet to its default state. The Parameters sorts dia-
log is displayed when Rebuild is clicked.

Parameters sorts dialog

The first time a user selects the Parameters panel Phoenix displays a dialog that prompts the user to 
select the sort variables to use to create the internal dosing worksheet. This dialog is only displayed if 
sort keys are selected.

The Parameters sorts dialog uses the sort variables specified in the Main Mappings panel. By default 
all sort variables are selected. 

• Click OK to accept the default sort variables.

• To select a subset of the sort variables, clear the checkbox beside the unwanted sort variable and 
click OK.

• To choose new sort variables, click Rebuild in the Parameters panel. The Parameters panel is 
cleared and the Parameters sorts dialog is displayed again.

Options tab

The Options tab allows users to select the Loo-Riegelman model and set options for the selected 
model. 

• Use the Weighting menu to select the regression that estimates Lambda Z or slopes. Available 
options include: User Defined, Uniform, 1/Y, 1/(Y*Y).
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Note: The relative proportions of the weights are important, not the weights themselves. See “Weighting” 
in the NCA section for more on weighting schemes. 

When selecting a weighting model, there are a couple of rules to consider:

If User Defined is selected then users can enter their own Observed to Power N value. The value 
of N must be typed in the Weighting text field.

When a log-linear fit is done (Uniform weighting for Lambda Z), then the fit is implicitly using a 
weighting approximately equal to 1/Yhat2.

Note: If 1/Y and the Linear Log Trapezoidal calculation method are selected, a user could assume that 
the weighting scheme is 1/LogY, rather than 1/Y. However, this is not the case because concentra-
tions between zero and one would have negative weights, and could not be included in the analy-
sis. 

• Use the Titles text box to type a title for the analysis.

The title is displayed at the top of each page in the Core output. The title can include up to five 
lines of text.

• Use the Calculation Method menu to select a calculation method.

Four methods are available for the calculation of area under the curve. The chosen method 
applies to all AUC and AUMC computations. All methods reduce to the log trapezoidal rule, the 
linear trapezoidal rule, or both. The methods differ based on when the rules are applied. See 
“Partial area calculation” for descriptive equations of the calculation methods.

Linear_Log_Trapezoidal: uses the log trapezoidal rule after Cmax, or after C0 if C0 > Cmax. 
Otherwise the linear trapezoidal rule is used. If Cmax is not unique, then the first maximum is 
used. This method uses linear trapezoids before Tmax and log trapezoids after Tmax.

Linear_Trapezoidal_Linear_Interpolation: This is the default method. It applies the linear trap-
ezoidal rule to each pair of consecutive points in the dataset that have non-missing values, and 
sums up these areas. This method uses linear trapezoids before and after Tmax.

Linear_Up_Log_Down: uses the linear trapezoidal rule any time that the concentration data is 
increasing, and the logarithmic trapezoidal rule is used any time that the concentration data is 
decreasing. This method uses linear trapezoids up and logarithmic trapezoids down before Tmax 
and linear trapezoids up and logarithmic trapezoids down after Tmax.

Linear_Trapezoidal_LinearLog_Interpolation: this method is the same as Linear_Trapezoi-
dal_Linear_Interpolation. It is used when a final time point, that is not in the dataset, is used for 
predictions. In that case, Phoenix inserts a final concentration value using the Linear_Trapezoi-
dal_Linear_Interpolation rule. The Linear_Trapezoidal_LinearLog Interpolation rule is used if the 
final time point is after Cmax, or after C0 if C0 > Cmax. If Cmax is not unique, then the first maxi-
mum is used. This method uses linear trapezoids before and after Tmax.

Note: The Linear Log Trapezoidal, the Linear Up Log Down, and the Linear Trapezoidal Linear/Log 
Interpolation methods all apply the same exceptions in area calculation and interpolation. If a Y 
value (concentration, rate, or effect) is less than or equal to zero, Phoenix defaults to the linear 
trapezoidal or linear interpolation rule for that point. If adjacent Y values are equal to each other, 
Phoenix defaults to the linear trapezoidal or linear interpolation rule.
No interpolation is performed in the Loo-Riegelman model.
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• Check the Page Breaks checkbox to include page breaks in the text output.

• Check the Intermediate Output checkbox to set text output to only include values for iterations 
during estimation of Lambda Z or slopes, and for each of the sub-areas in partial area computa-
tions.

• Check the Exclude Profiles with Insufficient data checkbox to exclude profiles with all or many 
missing parameter estimates from the results. 

If it is not selected, profiles with insufficient data will have missing output parameter values. See 
“Data deficiencies resulting in missing values for PK parameters” for a list of cases that produce 
missing estimates and are excluded by selecting this option. 

To set the dosing unit:

• Type the dosing unit into the Unit field.

• Click Preview to see a preview of dose option selections. 
The preview is opened in its own window. Click OK to close the preview window.

• Use the Normalization menu to select the appropriate factor if the dose amount is normalized by 
subject body weight or body mass index. Normalization menu options include: None, kg, g, mg, 
m**2, 1.73 m**2 

If doses are in milligrams per kilogram of body weight, select mg as the dosing unit and kg as the 
dose normalization. The Normalization menu affects the output parameter units. For example, if 
dose volume is in liters, selecting kg as the dose normalization changes the units to L/kg. Dose 
normalization affects units for all volume and clearance parameters, as well as AUCinf/D values.

Plots tab

In the Plots tab, users can select whether or not to produce plot output. 

• Use the checkboxes to toggle the creation of graphs.

• Click Reset Existing Plots to clear all existing plot output.

Each plot in the Results tab is a single plot object. Every time a model is executed, each object 
remains the same, but the values used to create the plot are updated. This way, any styles that 
are applied to the plots are retained no matter how many time the model is executed.

Clicking Reset Existing Plots removes the plot objects from the Results tab, which clears any 
custom changes made to the plot display.

• Use the Enable All and Disable All buttons to check or clear all checkboxes for all plots in the 
list. These buttons are most useful when there are many plots listed.

Results

Worksheet 

• Dosing Used: The dosing regimen specified for the modeling.
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• Exclusions: Excluded data points.

• Final Parameters and Final Parameters Pivoted: Lists the following values for each profile.

Rsq: Goodness of fit statistic for the terminal elimination phase.
Rsq_adjusted: Goodness of fit statistic for the terminal elimination phase, adjusted for the num-
ber of points used in the estimation of Lambda Z.
Lambda_z: First-order rate constant associated with the terminal (log-linear) portion of the curve. 
Estimated by linear regression of time vs. log concentration. 
No_points_lambda_z: Number of points used in computing Lambda Z. 
If Lambda Z is not estimable, then no points are used.

• Loo-Riegelman: Estimates for each profile, including time, concentration and cumulative AUC, 
amount in the peripheral compartment, amount absorbed, and relative fraction absorbed. Units 
are taken from the input data.

• Plot Titles: Lists the title of each Observed Y and Predicted Y vs X plot.

• Summary: Details for fitting Lambda Z. Not included for Loo-Riegelman with user-specified 
AUC.

Plots 

• Observed Y and Predicted Y vs X: Plot of the Lambda Z fit. This plot group is not created if 
AUC¥ is user-specified or if Lambda Z is user-specified.

• Relative Fraction Absorbed: Relative fraction absorbed vs time.

Text File 

• Core output: Text file that contains a complete summary of the model commands, options, 
parameters, and values for a PK model, as well as any errors that occurred during modeling.

• Settings: User-defined settings. 

Users can double-click a plot in the Results tab to edit it. (See the menu options descriptions in the 
Plots chapter of the Data Tools and Plots Guide for plot editing options.)
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Wagner-Nelson

The Wagner-Nelson model is a one-compartment IV-bolus model that uses deconvolution to estimate 
the fraction of drug absorption. The model also generates AUCs (Areas Under the Curve) and rate of 
absorption values. This deconvolution model is best used to calculate the absorption kinetics of intra-
venously administered drugs.

For drugs that are administered through methods other than IV-bolus, such as oral or transdermal 
methods, it is preferable to use the Deconvolution object to evaluate drug release and absorption. For 
more information on the Deconvolution object, see “Deconvolution”.

Use one of the following to add the object to a Workflow:

Right-click menu for a Workflow object: New > IVIVC > Wagner-Nelson 
Main menu: Insert > IVIVC > Wagner-Nelson.
Right-click menu for a worksheet: Send To > IVIVC > Wagner-Nelson.

Note: To view the object in its own window, select it in the Object Browser and double-click it or press 
ENTER. All instructions for setting up and execution are the same whether the object is viewed in 
its own window or in Phoenix view.

The user interface for Wagner-Nelson is the same as that for Loo-Riegelman, except that Loo-Riegel-
man has an additional Parameters panel. Click the following to view the interface description in the 
Loo-Riegelman section.

Main panel
Dosing panel
Slopes Selector panel
Slopes panel
Options tab
Plots tab

This section contains the following topics:

Wagner-Nelson inputs and calculations
Results

Wagner-Nelson inputs and calculations

The Wagner-Nelson method estimates the fraction of drug absorbed over time, relative to the total 
amount to be absorbed, following the method described in Gibaldi and Perrier (1975) pages 130 to 
133. It uses as a basis AUC values computed for each time point in the time-concentration data.

Note: Wagner-Nelson computations assume single-dose PK data with a concentration value of zero at 
dose time. If no concentration value exists at dose time, a value of zero is used.

The value of AUCINF (AUC) may be user-specified or compute as for non-compartmental analysis:

AUC=AUClast+Clast/Lambda_z

Either the observed or predicted value for Clast, where Clast_pred=exp(intercept – Lambda_z*tlast) can 
be used. As in the Wagner-Nelson method, the method for computing Lambda Z is specified by the 
user: best fit, user-specified range, or user-specified value. An intercept for the last case can be 
entered by the user. If the intercept is not specified, it will be computed using the last positive concen-
tration and associated time value:
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intercept=Lambda_z*tlast+ln(Clast)

The cumulative amount absorbed at time t, normalized by the central compartment volume V1, is 
computed as:

Cumul_Amt_Abs_V(t)=C(t)+Lambda_z*AUC(t)

Therefore, Cumul_Amt_Abs_V at t=infinity is:

Cumul_Amt_Abs_V(inf)=Lambda_z*AUC 

The relative fraction absorbed at time t is then:

Rel_Fraction_Abs(t)=Cumul_Amt_Abs_V(t)/Cumul_Amt_Abs_V(inf)

Data points with a missing value for either time or the concentration will be excluded from the analysis 
and will not appear in the output.

Results

Worksheet 

• Dosing Used: The dosing regimen specified for the modeling.

• Exclusions: Excluded data points.

• Final Parameters and Final Parameters Pivoted: Lists the following values for each profile.

Rsq: Goodness of fit statistic for the terminal elimination phase.
Rsq_adjusted: Goodness of fit statistic for the terminal elimination phase, adjusted for the num-
ber of points used in the estimation of Lambda Z.
Lambda_z: First-order rate constant associated with the terminal (log-linear) portion of the curve. 
Estimated by linear regression of time vs. log concentration. 
No_points_lambda_z: Number of points used in computing Lambda Z. 
If Lambda Z is not estimable, then no points are used.

Plot 

• Observed Y and Predicted Y vs X: Plot of the Lambda Z fit. This plot group is not created if
AUC is user-specified or if Lambda Z is user-specified.

• Relative Fraction Absorbed: Relative fraction absorbed vs time.

Text File

• Core output: Text file that contains a complete summary of the model commands, options,
parameters, and values for a PK model, as well as any errors that occurred during modeling.

• Settings: User-defined settings.

Users can double-click a plot in the Results tab to edit it. (See the menu options descriptions in the 
Plots chapter of the Data Tools and Plots Guide for plot editing options.)
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